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Welcome
Thank you for purchasing your Blackmagic Camera!

We have worked hard to produce three cameras that have 
been designed from the ground up to fit any kind of workflow. 
Our new Pocket Cinema Camera is a Super 16 digital film 
camera with 13 stops of dynamic range that is small enough  
to take anywhere. The Cinema Camera records uncompressed 
CinemaDNG RAW files for pristine images and our new 
Production Camera 4K is a Super 35 Ultra HD 4K camera  
with a global shutter and 6G-SDI output. 

Our cameras are designed to produce files that are "flat", 
which means they preserve the wide dynamic range from the 
sensor, as well as standard file formats that work with all video 
software. This allows you to make creative decisions by using 
the included DaVinci color correction software!

We think this means you get a cinema style shooting 
experience where you capture and preserve more of the  
image so you have as many creative options as possible.  
We have also included large screens on our cameras for 
easy focus and metadata entry. We hope you connect to our 
cameras in creative ways and produce some amazing looking 
images! We are extremely excited to see what creative work 
you produce!

Grant Petty 
CEO Blackmagic Design
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Introducing Blackmagic Cameras
Blackmagic Pocket Cinema Camera Features
1. RECORD BUTTON
Press this button to record clips to your SD card. See page 10.

2. TRANSPORT CONTROL
Use these buttons to play, skip or shuttle clips. See page 11.

3. LENS MOUNT
Micro Four Thirds lens mount for a wide selection of lenses. See page 7.

4. BATTERY TERMINAL
Open the battery door via the release button to:

 � Insert and remove the rechargeable Lithium Ion battery. See page 8.
 � Insert a SDHC or SDXC card for recording. See page 9.
 � Access the USB Mini-B port for software configuration and updates. See page 39.

5. LANC REMOTE
The 2.5mm stereo jack for LANC remote control supports record start and stop, iris control, and manual focus.  
See page 16.

6. HEADPHONES
3.5 mm stereo headphone jack connection. See page 16.

7. AUDIO IN
3.5mm stereo jack for mic or line level audio. See pages 16 and 20.

8. HDMI OUT
Micro HDMI port for monitoring or outputting video to a switcher. See page 16.

9. POWER
0.7mm 12 – 20V power input for power and battery charging. See page 16.

10. LCD
Watch the LCD while recording or playing back a clip. See page 27.

11. CONTROL BUTTONS
Use these buttons for power, menu navigation, iris control, focus peaking, auto focus, LCD zoom and 
additional on screen displays. Use the up and down buttons for opening and closing the on screen displays 
and the left and right buttons to manually nudge the iris open and closed on the lens by a small amount.
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Blackmagic Cinema Camera and Production Camera 4K Features
1. RECORD BUTTON
Record clips to your SSD. See page 10.

2. IRIS BUTTON
The Iris button activates electronic iris control on the Cinema Camera and Production Camera 4K EF 
models. Adjust the aperture of your lens by pressing the forward and reverse skip/shuttle playback 
buttons. See page 26.

3. TOUCHSCREEN LCD
Watch the LCD monitor while recording or playing back a clip, or when using the menu. Use the touchscreen 
to activate additional on screen displays while shooting. See pages 11, 24, 25 and 28.

4. FOCUS BUTTON
Press the Focus button for focus peaking on the LCD. See page 26.

5. TRANSPORT CONTROLS
Press these buttons to stop, skip/shuttle, or play your clips. See page 11.

6. MENU BUTTON
Access the dashboard menu on the LCD for settings and features. See pages 13 and 18.

7. POWER BUTTON
Press the power button to turn on the Blackmagic Cinema Camera. Press and hold the button to turn 
the camera off. See page 8.

8. LANC REMOTE
The 2.5mm stereo jack for LANC remote control supports record start and stop, and iris and focus control 
on EF mount models. See page 17.

9. HEADPHONES
3.5 mm stereo headphone jack connection. See page 17.

10. AUDIO IN
2 x 1/4 inch balanced TRS phono jacks for mic or line level audio. See pages 17 and 20.

11. SDI OUT
SDI output for connecting to a switcher or to DaVinci Resolve via capture device for live grading. See 
pages 17 and 33.

12. THUNDERBOLT CONNECTION
Blackmagic Cinema Camera outputs 10-bit uncompressed 1080p HD. Production Camera 4K also outputs 
compressed Ultra HD 4K. Use the Thunderbolt connection for HD UltraScope waveform monitoring and 
streaming video to a Thunderbolt compatible computer. See pages 17 and 29.

13. POWER
12 – 30V power input for power supply and battery charging. See pages 8 and 17.
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Attaching a Lens
Getting started with your Blackmagic Camera is as simple as attaching a lens and turning the camera on. 
To remove the protective dust cap from the EF lens mount, hold down the locking button and rotate the 
cap counterclockwise until it is released. For the PL mount, rotate the PL locking ring counterclockwise. 
We recommend always turning off your Blackmagic camera prior to attaching or removing a lens.

To attach an EF mount lens:

Step 1. Align the dot on your lens with the dot on the camera mount. Many lenses have a visual 
indicator, for example a blue, red or white dot.

Step 2. Twist the lens clockwise until it locks into place.

Step 3. To remove the lens, hold down the locking button, rotate the lens counterclockwise until its 
dot or indicator reaches the 12 o’clock position, and gently remove.

To attach a PL mount lens:

Step 1. Open your camera's PL locking ring by rotating it counterclockwise until it stops. 

Step 2. Align one of the lens' four flange notches with the locating pin on the camera mount. Be sure 
to align the lens for easy viewing of the lens marks.

Step 3. Tighten the camera's PL locking ring by rotating it clockwise.

Step 4. To remove the lens, rotate the locking ring counterclockwise until it stops, then gently remove 
the lens.

When no lens is attached to the camera, the sensor is exposed to dust and other debris so you'll want 
to keep the dust cap on whenever possible.SSD

SSD

SSD

SSD

Attaching and removing an EF lens on Cinema Camera  
and Production Camera 4K.

Attaching and removing a lens on Pocket Cinema Camera.
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Attaching and removing a PL lens on Cinema Camera PL  
and Production Camera 4K PL.
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Turning Your Camera On
Pocket Cinema Camera
Before you can operate Pocket Cinema Camera, you need to insert the battery.

Step 1. On the under side of the camera, push the door release towards the lens to access the 
battery terminal.

Step 2. With the gold contacts facing into the terminal and the white arrow facing the lens, hook the 
lip of the battery under the orange tab and insert the battery until you feel it press into place.  
Push the orange tab to release the battery.

Step 3. Close the door to the battery terminal and slide the door release to the right to lock it.

Step 4. Press the power button on the bottom right of the back panel. The status strip will appear 
along the top of the LCD.

Step 5. Press and hold the power button to switch off the camera.

Congratulations! You are now ready to insert an SD card and start recording!

Cinema Camera & Production Camera 4K
Cinema Camera and Production Camera 4K models have internal batteries that can be charged using 
the supplied power adapter. The camera can be charged and operated while connected via external 
power and will switch between power sources without any interruption.

You can also charge the camera via a powered USB connection, however it takes longer to charge so 
we recommend using the power adapter when possible.

Step 1. Press the power button below the touchscreen. The status strip will appear along the top of 
the LCD.

Step 2. Press and hold the power button to switch off the camera. 

Congratulations! You are now ready to insert an SSD and start recording!

Press and hold the power button to turn the camera on or off.

Use the supplied power adapter to charge the internal  
battery and power the camera.

Inserting the battery into Pocket Cinema Camera.
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Inserting an SD Card
You can insert an SDXC or SDHC card into Blackmagic Pocket Cinema Camera:

Step 1. On the under side of the camera, push the door release towards the lens to access the 
battery terminal.

Step 2. With the gold contacts on the SD card facing towards the lens, insert the SD card until you 
feel it lock into place. Push on the SD card to release it.

Step 3. Close the door to the battery terminal and slide the door release to the right to lock it.

Step 4. Power on the camera. The status strip will display a moving dot while the camera checks the 
SD card and then it will say READY.

The supplied SD card is for software installation only and not suitable for video recording. You'll find a 
list of recommended SD cards on page 13.

Inserting an SSD
You can insert a 2.5" 9.5 mm SSD formatted in either the HFS+ or exFAT file systems into Cinema Camera 
and Production Camera 4K:

Step 1. Open the SSD door on the right hand side of the camera.

Step 2. With the gold SATA contacts facing towards the camera door, insert the SSD until you feel it 
press into place. Close the SSD door.

Step 3. Power on the camera. The status strip will display a moving dot while the camera checks the 
SSD and then it will say READY.

You'll find a list of recommended SSDs on page 12.

Inserting an SSD into the Cinema Camera and the Production 
Camera 4K.

Inserting an SD card into the Pocket Cinema Camera.
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Press the REC button on the front face

or

on the transport control on the back of Cinema Camera and 
Production Camera 4K.

Press the REC button on the top of Pocket Cinema Camera.

Recording
Press the REC button on your camera to begin recording immediately. Press REC again to stop recording.

Choosing the Recording Format
Blackmagic cameras record to several different formats, depending on which model you are using.  
You may decide to experiment to see which format best suits your workflow. 

You can choose from 4 different Apple ProRes formats. This lets you fit more video on your SSD or SD 
card. ProRes 422 (HQ) provides the highest quality video with the lowest compression. Alternatively, 
ProRes 422 Proxy gives you far more recording time with greater compression.

To select your desired video format:

Step 1. Press the MENU button to open the dashboard and select Settings.

Step 2. Select the RECORDING menu and use the selection arrows to set the desired recording format.

Step 3. Press the MENU button twice to exit.

Your camera is now ready to record in the video format you have selected. The current recording format 
is shown on the LCD status strip.

Blackmagic Pocket  
Cinema Camera

Blackmagic Cinema Camera Blackmagic Production  
Camera 4K

Apple ProRes 422 (HQ) Apple ProRes 422 (HQ) Apple ProRes 422 (HQ)

Apple ProRes 422 Apple ProRes 422 Apple ProRes 422

Apple ProRes 422 LT Apple ProRes 422 LT Apple ProRes 422 LT

Apple ProRes 422 Proxy Apple ProRes 422 Proxy Apple ProRes 422 Proxy

Lossless compressed  
CinemaDNG RAW

CinemaDNG RAW 2.5K Lossless compressed  
CinemaDNG RAW

Avid DNxHD
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Blackmagic Cameras Supported Video Formats

Playing Back Clips
Once you have recorded your video, you can use the transport control buttons to play back your video 
on the LCD.

Press the play button once for instant playback and you'll see your video on the LCD and on any display 
connected to the HDMI or SDI output. Hold down the forward or reverse buttons to fast forward or 
reverse through the clip. Playback will finish when the end of the current clip is reached.

The controls of your camera work just like a CD player, so pressing the forward button will skip to the 
start of the next clip. Press the reverse button once to go to the start of the current clip or press twice 
to skip back to the start of the previous clip.

To immediately view your recorded clip on a Blackmagic 
Camera simply press the Play button on the transport controls.

Blackmagic Pocket  
Cinema Camera

Blackmagic Cinema Camera Blackmagic Production  
Camera 4K

1920 x 1080p23.98 2400 x 1350 12-bit 2.5K RAW 4000 x 2160 12-bit RAW

1920 x 1080p24 1920 x 1080p23.98 3840 x 2160p23.98

1920 x 1080p25 1920 x 1080p24 3840 x 2160p24

1920 x 1080p29.97 1920 x 1080p25 3840 x 2160p25

1920 x 1080p30 1920 x 1080p29.97 3840 x 2160p29.97

1920 x 1080p30 3840 x 2160p30

1920 x 1080i50 (output) 1920 x 1080p23.98

1920 x 1080i59.94 (output) 1920 x 1080p24

1920 x 1080p25

1920 x 1080p29.97

1920 x 1080p30

1920 x 1080i50 (output)

1920 x 1080i59.94 (output)
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Choosing a Fast SSD
When working with high data rate video it's important to carefully check the SSD you would like to use.  
This is because some SSDs can have up to 50% lower write speed than the manufacturer’s claimed speed, 
so even though the disk specifications claim an SSD is fast enough to handle video, in reality the disk is 
not fast enough for real time video recording.

The following SSDs are recommended for 4K RAW and ProRes captures:

The following SSDs are recommended for 2.5K RAW CinemaDNG capture or compressed video capture:

In addition to the above, these SSDs work ONLY for compressed video capture:

If your SSD is dropping frames, try a different SSD or use a compressed HD recording format such as 
ProRes or DNxHD for lower data rates. Check the Blackmagic Design website for the latest information.

Kingston HyperX 240GB SSD

Intel 335 Series 240GB SSD

About SSDs and SD Cards

Sandisk Extreme 480GB SSD

 � Intel 335 Series 240GB SSD 
 � Intel 520 Series 240GB SSD 
 � Intel 520 Series 480GB SSD 
 � Intel 530 Series 180GB SSD
 � Intel 530 Series 240GB SSD
 � Kingston 240 GB HyperX 3K
 � Kingston 480 GB HyperX 3K
 � Kingston 240 GB SSDNow KC300
 � Kingston 480 GB SSDNow KC300
 � Sandisk Extreme 240GB
 � Sandisk Extreme 480GB
 � PNY 240GB Prevail SSD (firmware 5.0.2) 
 � OWC 120GB Mercury Extreme Pro 6G 

(Firmware Rev 5.0.7)

 � OWC 240GB Mercury Extreme Pro 6G 
(Firmware Rev 5.0.6)

 � OWC 480GB Mercury Extreme Pro 6G 
(Firmware Rev 5.0.6)

 � Digistor 128GB SSD Professional Video 
Extreme (pre-formatted ExFat)

 � Digistor 240GB SSD Professional Video 
Series (pre-formatted ExFat)

 � Digistor 480GB SSD Professional Video 
Series (pre-formatted ExFat)

 � Angelbird 240GB AV Pro (Firmware 2.54)
 � ADATA XPG SX900 256GB

 � Sandisk Extreme Pro 240GB  
(SDSSDXPS-240G-G25)

 � Sandisk Extreme Pro 480GB  
(SDSSDXPS-480G-G25)

 � Sandisk Extreme Pro 960GB  
(SDSSDXPS-960G-G25)

 � Crucial 256GB M4 (firmware 000F)
 � OCZ Agility 3 240GB

 � Sandisk Extreme 120GB
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Choosing a Fast SD Card
It's important to use SDHC and SDXC cards with Blackmagic Pocket Cinema Camera. These cards are 
rated for fast data speeds and support larger storage sizes.

Recommended SDHC and SDXC cards include:

 � Delkin Devices 16GB Elite SDHC UHS-I  � Sandisk 64GB Extreme SDXC UHS-I  � Sandisk 16GB Extreme Pro SDHC UHS-I

 � Delkin Devices 32GB Elite SDHC UHS-I  � Sandisk 128GB Extreme SDXC UHS-I  � Sandisk 64GB Extreme Pro SDHC UHS-I

Please check the tech notes on the Blackmagic Design website for the latest information.

Preparing Media for Recording
SSDs used by Cinema Camera and Production Camera 4K, and SD cards used by Pocket Cinema Camera 
must be formatted as either HFS+ or exFAT. These disk formats allow long clips to be recorded as single 
files and can be formatted using the Format Disk feature on the dashboard. You can also format SD 
cards and SSDs via a Mac or PC computer.

HFS+ is also known as Mac OS Extended. It is the recommended format as it supports "journaling".  
Data on journaled media is more recoverable and less likely to be corrupted. HFS+ is natively supported 
by Mac OS X. 

ExFAT is supported natively by Mac OS X and Windows without needing to purchase any additional 
software. However, exFAT does not support journaling which means data is less protected against the 
rare event your media card or SSD is corrupted.

To format your SSD or SD card using the dashboard Format Disk feature:

Step 1.  Press the Menu button to open the dashboard.

Step 2.  Select the Format Disk icon by tapping on the touchscreen or by using the navigation  
and OK buttons on the Pocket Cinema Camera.

Step 3.  Choose your format by selecting the HFS+ or exFAT icon.

Step 4.  A warning will appear asking you to confirm the format. Select "Yes, format my disk"  
to continue, or 'Cancel' to cancel the format.

Step 5.  A progress bar shows you the progress of the format. 'Complete' will appear when the format 
is done.

Step 6.  Select the Done icon to return to the dashboard.

Select the Format Disk icon on the camera dashboard 
to format your SSD or SD card.

Choose from HFS+ or exFAT formats. Confirm your 
selection by tapping the 'Yes, format my disk' icon to 
continue, or 'Cancel' to cancel the format.
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Preparing SSDs and SD Cards on a Mac OS X computer
Use the Disk Utility application included with Mac OS X to format your SSD or SD card in the HFS+ or 
exFAT formats. Remember to back up anything important from your media as all data will be lost when 
it is formatted.

Step 1. Connect the SSD to your computer with an external dock or cable adapter and dismiss any 
message offering to use your SSD for Time Machine backups. Plug an SD card into your 
computer's SD card slot or via an SD card reader.

Step 2. Go to Applications/Utilities and launch Disk Utility.

Step 3. Click on the disk icon of your SSD or SD card and then click the Erase tab.

Step 4. Set the Format to "Mac OS Extended (Journaled)" or "exFAT".

Step 5. Type a Name for the new volume and then click Erase. Your SSD or SD card will quickly be 
formatted and made ready for use.

Preparing SSDs on a Windows computer
The Format dialog box can format an SSD or SD card in the exFAT format on a Windows PC. Remember 
to back up anything important from your media as all data will be lost when it is formatted.

Step 1. Connect the SSD or SD card to your computer.

Step 2. Open the Start Menu or Start Screen and choose Computer. Right-click on your SSD  
or SD card.

Step 3. From the contextual menu, choose Format.

Step 4. Set the file system to "exFAT" and the allocation unit size to 128 kilobytes.

Step 5. Type a volume label, select "Quick Format" and click "Start".

Step 6. Your SSD or SD card will quickly be formatted and made ready for use.

Use Disk Utility on Mac OS X to erase your SSD or SD card  
in the Mac OS Extended (Journaled) or exFAT format.

Use the Format dialog box feature in Windows  
to format your SSD or SD card in the exFAT format.
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Checking Disk Speed
Blackmagic Disk Speed Test is a fun application that measures the read and write performance of storage 
media, then displays the results using video formats.

If you have ever wondered whether your hard drive is suitable for recording ("write") or playback (“read”) 
of a particular video format, you can use Disk Speed Test to find out. Test the performance of your media 
drives with a single click of the Start button! Disk Speed Test will even show you how many streams of 
video your storage is capable of handling.

Disk Speed Test is included free in the Blackmagic Camera Software Utility supplied with your Blackmagic 
Cinema Camera and Production Camera 4K. The Blackmagic Camera Software Utility can also be 
downloaded from our website free of charge.

Use Disk Speed Test to find out the performance of your  
media drives.

Disk Speed Test interface.
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Blackmagic Pocket Cinema Camera
LANC Remote Control
The remote port on your camera is used to remotely control record starting and stopping, iris adjustments 
and manual focus adjustments when using a compatible lens.

The port is a 2.5 mm stereo jack using the standard LANC protocol.

Headphones
Monitor audio while recording or playing back clips by plugging your headphones into the 3.5mm stereo 
headphones jack.

Audio In
The 3.5mm stereo audio connector accepts microphone or line level audio. It's important to select the 
appropriate setting or your audio may sound too quiet or too loud. The camera automatically switches 
to line level if the audio is too loud for a sustained period.

HDMI Out
The micro HDMI port outputs 10-bit uncompressed HD1080p video, even while recording. It can be 
used to output video to routers, monitors, capture devices, broadcast switchers and other HDMI devices.

Power
Use the 0.7mm 12 – 20V power input for connecting your power supply and to charge the battery.

USB
Use the USB port to connect your Blackmagic Pocket Cinema Camera to your computer and update the 
internal software. The USB port can be found inside the battery compartment.

Connections
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Blackmagic Cinema Camera and Production Camera 4K
LANC Remote Control
The remote port on your camera is used to remotely control record starting and stopping, plus iris and 
focus adjustments when using a compatible lens on Cinema Camera and Production Camera 4K EF models.

The port is a 2.5 mm stereo jack using the standard LANC protocol.

Headphones
Monitor audio while recording or playing back clips by plugging your headphones into the 3.5mm stereo 
headphones jack.

Audio In
The 1/4 inch TRS Phone audio connectors accept microphone or line level audio. It's important to select 
the appropriate setting or your audio may sound too quiet or too loud. The camera automatically switches 
to line level if the audio is too loud for a sustained period.

SDI Out
Blackmagic Cinema Camera supports 3G-SDI so it can be used to output uncompressed 10-bit 4:2:2 
video to routers, monitors, SDI capture devices, broadcast switchers and any other SDI devices. 

Production Camera 4K supports 6G-SDI, so it can be used to connect to any SDI monitor as well as 4K 
switchers such as ATEM Production Studio 4K.

Thunderbolt
When connected to a Mac OS X or Windows computer with Thunderbolt technology, your Cinema 
Camera or Production Camera 4K can be used as a powerful solution for waveform monitoring and 
color correction. Blackmagic Cinema Camera's Thunderbolt port always outputs 10-bit uncompressed 
HD1080p video. Production Camera 4K's Thunderbolt port matches the SDI output, which can be 10-bit 
uncompressed HD1080p or Ultra HD 4K.

Power
Use the 12 – 30V power input for connecting your power supply and to charge the internal battery.

USB
Use the USB port to connect your Blackmagic Cinema Camera or Production Camera 4K to your computer 
and update the internal software. Open the SSD door to access the USB port.
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Dashboard
The dashboard feature is opened by pressing the Menu button. From the dashboard you can 
access the Settings menu and key features such as metadata, media formatting, activating meters, 
frame guides and focus peaking. Press Menu again to exit the dashboard.

Camera Settings
To configure camera settings on your Blackmagic camera, press the MENU button to open the 
dashboard, select the Settings icon, then select the camera icon to the left of the settings menu.

Pocket Cinema Camera
Press the up and down buttons to highlight each settings menu. Press OK to enter a settings 
menu. Use the left and right directional arrows to adjust values and the up and down arrows to 
move between settings. Press Menu again to return to selecting between main settings pages. 

Cinema Camera & Production Camera 4K
Tap or slide the relevant arrows and icons on the touchscreen to change values or switch between 
settings menus.

Camera ID
If using more than one Blackmagic Camera, it's helpful to set each camera's ID which will be 
included with any metadata recorded with your clips. Set the camera ID with the onscreen 
keyboard. When you have finished entering a new camera ID, select Enter to save, or select 
Cancel to discard any changes.

Setting Date and Time
To set date and time on your Pocket Cinema Camera, select the + or - buttons to change the 
year, month and day settings.

Time is set to 24 hour format on Blackmagic Cameras. To set the time, select the + and - keys to 
make adjustments to the time. If traveling with your Blackmagic Camera, remember to change 
the date and time to local time zones.

If you have your Blackmagic Camera stored for long periods, the time may need to be reset. 
It is always a good idea to check the time and date prior to recording. When connecting your 
camera to your computer via USB and launching Blackmagic Camera Utility, your computer's 
time is synced to your camera.

Change the camera ID using the onscreen keyboard.

The Camera settings screen lets you adjust key features such 
as ISO, white balance, shutter angle, date, time and camera ID.

Settings

Press the Menu button to open the dashboard.
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ISO
ISO settings are helpful when you are shooting in a variety of light conditions. The optimum ISO 
setting for the Pocket Cinema Camera and Cinema Camera is 800ASA with a maximum ISO of 
1600ASA. For Production Camera 4K the optimum setting is 400ASA with a maximum ISO of 800ASA.

Depending on your situation, however, you may choose a lower or higher ISO setting. For example, 
in low light conditions 1600ASA would be suitable, or 800ASA for Production Camera 4K, but may 
introduce some visible noise. In bright conditions 400ASA, or 200ASA on Production Camera 
4K, would be best to record richer colors.

Adjust the ISO settings using the arrow icons in the menu.

White Balance
Blackmagic Cameras include white balance presets for a variety of color temperature conditions. 
Each light source emits a warm or cool color. Warm appears red and cool appears blue, so the 
white balance setting adds opposing red or blue to compensate. This makes sure white stays 
white in your image. Color temperature also changes depending on the position of the sun and 
the cloud conditions. For example, light is warm at sunrise, cools down until midday, then warms 
up again as the sun sets. Shady areas in your picture, including overcast conditions, will generally 
appear blue. Use the following guide to set your white balance to compensate for the changing 
light conditions:

 � 2500, 2800, 3000, 3200, 3400, 3600, 4000, 4500 and 4800K for various conditions 
under tungsten, incandescent or fluorescent light, or under dull natural light including 
candle light, sunrise/sunset, morning, and after noon light.

 � 5000, 5200, 5400 and 5600K for outdoors on a clear, sunny day.
 � 6000, 6500, 7000, 7500 and 8000K for a variety of daylight conditions.

Adjust the White Balance settings using the arrow icons in the menu.

Shutter Angle
Shutter angle complements the ISO setting by regulating the amount of light on the sensor.  
180 degrees is the optimum shutter angle, however as lighting conditions change you may need 
to adjust accordingly. For example, 360 degrees is considered 'wide open' and allows maximum 
light onto the sensor. This is useful for low light conditions. If you notice lights are flickering,  
172.8 degrees will minimize this effect when shooting 24p in countries with 50 hertz power supplies.

Adjust the Shutter Angle settings using the arrow icons in the menu.

The Camera settings screen.
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Audio Settings
To adjust audio input and audio monitoring settings on your Blackmagic Camera, press the MENU 
button to open the dashboard, select the Settings icon, then select the microphone icon to the 
left of the settings menu.

Microphone Input
Microphone input adjusts the recording levels of the built in microphone. Move the audio slider 
left or right to increase or decrease levels. Pocket Cinema Camera has a built in stereo microphone 
and Cinema Camera and Production Camera 4K have built in mono microphones. The built in 
microphones record to audio channels 1 and 2 when no external audio source is connected.

Channel 1 and 2 Input Levels
External audio connectors accept audio at microphone level or line level. It's important to select 
Mic or Line level audio as appropriate to avoid your external audio sounding almost inaudible 
or too hot and distorted.

Set the external audio input levels by using the left and right arrows. To prevent damage, the 
camera will automatically switch to line level input if the input levels are over the limit for a 
sustained period of time.

Channel 1 Input Level
Move the audio slider icon left or right to increase or decrease levels for channel 1. The external 
audio input overrides the built in microphone and is recorded to audio channel 1.

Channel 2 uses Channel 1 Input
Select Yes if you only have channel 1 input and want to record the same external audio to channels 
1 and 2. You can leave this set to No if you only want to record one channel of audio.

Channel 2 Input Level
Move the audio slider icon left or right to increase or decrease levels for channel 2. The external 
audio input overrides the built in microphone and is recorded to audio channel 2.

Headphone and Speaker Volume
When headphones are connected, a headphone icon will be displayed. When no headphones 
are detected, a speaker icon will be displayed. Headphones will always be active when recording 
or playing back, however speakers will only work when playing back. Move the volume slider left 
or right to increase or decrease audio monitoring levels.

The Audio settings screen lets you adjust the microphone 
input level, input level type, audio channel levels, mirror Ch 1 
audio to Ch 2, and adjust the headphones or speaker volume.
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Recording Settings
The recording settings are used to set the video format recorded to your SD card or SSD. Press 
the MENU button to open the dashboard, select the Settings icon, then select the circular record 
icon to the left of the settings menu.

Recording Format
Pocket Cinema Camera 
Press the left and right arrow buttons to switch between ProRes HQ, ProRes 422, ProRes LT, ProRes 
Proxy or RAW recording formats.

Cinema Camera
Tap the arrow icons to switch between 2.5K RAW, ProRes HQ, ProRes 422, ProRes LT, ProRes Proxy 
or DNxHD recording formats.

Production Camera 4K
Tap the arrow icons to switch between HD formats such as ProRes HQ, ProRes 422, ProRes LT and 
ProRes Proxy, or switch between 4K ProRes HQ, 4K ProRes 422, 4K ProRes LT, 4K ProRes Proxy, 
or 4K RAW recording formats.

Dynamic Range
Blackmagic Cameras have two dynamic range settings:

Film
The film setting shoots video using a log curve and gives you 13 stops of dynamic range on 
both Pocket Cinema Camera and Cinema Camera, or 12 stops on Production Camera 4K.  
The Film dynamic range setting maximizes the information in your video signal to help you get 
the most out of color grading software, such as DaVinci Resolve. When recording in CinemaDNG 
RAW formats, only the Film dynamic range setting is available.

Video
The video setting uses the REC709 standard for high definition video. This lets you work faster by 
recording directly to the compressed video formats your camera supports, which are compatible 
with popular post production software.

Adjust the dynamic range settings using the arrow icons in the menu.

The Recording settings screen lets you set your recording 
format, frame rate and time lapse interval, and select between 
film and video dynamic range.
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Frame Rate
Your Blackmagic Camera has five different frame rate settings for shooting common film and 
video frame rates: 23.98 fps, 24 fps, 25 fps, 29.97 fps, 30 fps.

Adjust the frame rate setting using the arrow icons in the menu.

Time Lapse Interval
This setting allows you to record a still frame at the following intervals: 

Frames: 2 - 10

Seconds: 1 - 10, 20, 30, 40, 50

Minutes: 1 - 10

For example, you can set the camera to record a still frame every 10 frames, 5 seconds, 30 seconds, 
5 minutes etc.

The Time Lapse feature offers many creative options. For example, if the Time Lapse interval is 
set to record a frame at 2 frame intervals, this will give your recorded video a high speed effect 
when played back.

The format of each still frame is based on your recording format, so if you set the camera to record 
in ProRes 422 HQ, the Time Lapse setting will maintain this format. The frame rate will be based 
on the video frame rate you have set the camera to, i.e., 24fps, so your time lapse footage can be 
incorporated into your workflow easily.

When the REC button is pressed in Time Lapse mode, the "TIME LAPSE RECORD" icon will replace 
the standard record icon. The timecode counter updates when a frame of video is recorded, 
meaning the rate of timecode increments depends on the Time Lapse interval setting.

Use the arrow icons to choose a Time Lapse interval or leave it set to Off if you do not want to 
use the Time Lapse feature.

The Recording settings screen.
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File Naming Convention
Pocket Cinema Camera
Pocket Cinema Camera uses the following file naming convention when recording video.

[Camera ID]_[Reel Number]_[yyyy-mm--dd]_[hhmm]_C[Clip number].mov

The table below shows an example of how this would appear on the LCD:

BMC01_1_2012-08-08_1631_C0002.mov QuickTime Movie Filename

BMC01_1_2012-08-08_1631_C0002.mov Camera ID

BMC01_1_2012-08-08_1631_C0002.mov Reel Number

BMC01_1_2012-08-08_1631_C0002.mov Date (2012 Aug 08)

BMC01_1_2012-08-08_1631_C0002.mov Time (16:31pm - 24hrs)

BMC01_1_2012-08-08_1631_C0002.mov Clip Number

For CinemaDNG files, the folder of the image sequence will also be named the same way.

Blackmagic Cinema Camera and Production Camera 4K
Clips are recorded to your SSDs in the CinemaDNG RAW format or to a ProRes or DNxHD QuickTime 
movie, depending upon which recording format you have chosen. Blackmagic Cinema Camera and 
Production Camera 4K use the following file naming convention when recording video.

[Camera ID]_[Reel Number]_[yyyy-mm--dd]_[hhmm]_C[Clip number].mov

The table below shows an example of how this would appear on the camera's touchscreen:

BMC01_1_2012-08-08_1631_C0002.mov QuickTime Movie Filename

BMC01_1_2012-08-08_1631_C0002.mov Camera ID

BMC01_1_2012-08-08_1631_C0002.mov Reel Number

BMC01_1_2012-08-08_1631_C0002.mov Date (2012 Aug 08)

BMC01_1_2012-08-08_1631_C0002.mov Time (16:31pm - 24hrs)

BMC01_1_2012-08-08_1631_C0002.mov Clip Number

For CinemaDNG files, the folder of the image sequence will also be named the same way.
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Display settings
To adjust the display settings for the LCD, press the MENU button to open the dashboard,  
select the Settings icon, then select the television icon to the left of the settings menu.

Dynamic Range
The LCD allows you to view your video as you are recording. You can set the dynamic range of 
the LCD by selecting Video or Film.

The dynamic range setting of the LCD is independent to the dynamic range set in the recorder 
settings. Some people prefer to monitor video with the LCD set to Video even when the recording 
format is set to Film.

Adjust the dynamic range setting of the LCD using the arrow icons in the menu.

Brightness
Move the slider icon left or right to adjust brightness settings for the LCD.

Zebra
Blackmagic Cameras have a zebra feature which gives an indication of exposure levels. Diagonal 
lines will appear across any part of the video that exceeds the zebra exposure level. 

Turn zebra on and select the desired zebra warning level by using the left and right arrows.

SDI/HDMI Overlays
You can monitor your video on an external display using the HDMI port on Pocket Cinema Camera, 
or the SDI port on Cinema Camera and Production Camera 4K. 

The SDI or HDMI Overlays setting lets you display useful information on your monitor. Use the 
arrow icons to select which overlays to display on your SDI or HDMI feed.

All: displays both frame guides and recording information.

Status: displays only the recording information, such as f-stop number, frame rate, battery life etc.

Guides: displays only the frame guides.

Off: gives you a clean feed.

You can also view guides on the camera LCD by opening the dashboard and selecting  
the Frame Guides icon.

The Display settings screen on Cinema Camera and 
Production Camera 4K. Display settings lets you set the  
LCD brightness and dynamic range, Zebra and SDI overlays.

SDI/HDMI Overlays set to display on an external monitor.
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On Screen Metering
Your Blackmagic Camera features additional displays such as Recording Time Remaining, Histogram and 
Peak Audio Meters to assist when setting optimum exposure and to prevent your audio from clipping. 

View the additional displays by swiping up from the bottom of the touchscreen with your finger. Hide the 
additional displays by swiping down. On the Pocket Cinema Camera, press the Up directional button 
to reveal the displays, and press the Down button to hide the displays. On screen meters can also be 
opened or hidden by selecting or deselecting the Meters feature on the dashboard.

Histogram
The Histogram display shows the distribution of the luminance in your video. Pure black is on the far left 
side of the display and pure white is on the far right of the display. Keeping your video signal within these 
limits prevents your shadows and highlights from being clipped and preserves detail in the tonal ranges.

Recording Time Remaining
The Recording Time Remaining indicator shows the remaining recording time for your SSD. The time is 
shown in hours and minutes and will vary according to your selected frame rate and codec, for example, 
ProRes 422 HQ at 24 frames per second. The indicator will automatically recalculate if either of these 
settings are changed. When there is approximately 5 minutes remaining on your SSD, the indicator will 
turn RED, and will BLINK intermittently when there is only 2 minutes remaining.

Peak Audio Meters
The Peak Audio Meters display audio levels for channels 1 and 2 when using the internal microphone, 
or via external audio when connected. The display is calibrated to dBFS units and features peak hold 
indicators which stay visible for a short time so you can clearly see the maximum levels reached. To 
achieve optimum audio quality, ensure your audio levels never rise above 0 dBFS. If your audio rises 
above 0 dBFS, the peak hold indicators will turn red, indicating that audio is clipped.

On screen metering and status strip on the Blackmagic 
Cinema Camera. Swipe up from the bottom of the screen  
to reveal the metering displays.

To set optimum exposure, open or close your aperture until 
the histogram curve sharpens to a point at the bottom edges.
If you see a flat edge on the right side of the histogram, your 
whites are clipped, a flat edge on the left side means your 
blacks are clipped.

Use the recording time remaining indicator to see how much 
recording time is available on your SSD or SD card.

To set optimum audio levels, adjust the camera microphone 
or channel input level until the audio peak averages at -12dB, 
but does not peak beyond 0dB.
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Adjusting Settings
Blackmagic Pocket Cinema Camera, Cinema Camera EF and Production Camera 4K EF support electronic 
lens control, which allows you to adjust lens controls from the camera such as aperture and auto focus. 
Cinema Camera MFT and PL mount camera models have a passive lens mount if you want to use manual 
lenses without electronic control. The focus peaking feature creates a green edge around the sharpest 
parts of the image so you can easily confirm your focus. Focus peaking is visible on the LCD and via SDI 
or HDMI out with Overlays set to On, but does not affect your recorded picture.

Iris Button
When using Video dynamic range settings, a single press of the Iris button will set an average exposure 
based on the highlights and shadows in your shot. When using Film dynamic range settings, pressing 
the IRIS button sets your exposure to the brightest highlight in your shot.

To set your aperture manually on Pocket Cinema Camera press the left and right directional buttons 
on the back panel.

To set your aperture manually on Cinema Camera and Production Camera 4K press the forward and 
reverse buttons on the transport controls.

Focus Button
When using a compatible auto focus lens with Pocket Cinema Camera, or Cinema Camera and Production 
Camera 4K EF models, press the FOCUS button once to auto focus. A quick double press of the FOCUS 
button activates focus peaking.

When using a manual lens, press the FOCUS button once for focus peaking.

Focus Zoom
When using Pocket Cinema Camera, double press OK to zoom in for adjusting focus at the 1:1 pixel 
scale. Double press OK again to zoom out.

On Cinema Camera and Production Camera 4K, double tap the touchscreen display to zoom into the 
image for adjusting focus at the 1:1 pixel scale. Double tap the display again to zoom out.

On Pocket Cinema Camera, press the IRIS button, then use 
the left and right directional buttons to adjust aperture 
control. Press the FOCUS button for focus peaking.

On Cinema Camera and Production Camera 4K EF models, 
press the IRIS button, or use the transport controls to adjust 
aperture control. Press the FOCUS button for focus peaking. 
The FOCUS button also activates auto focus on EF mount 
models using a compatible lens.

OK

MENU

IRIS FOCUS

IRIS FOCUS
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Image Stabilizer
Pocket Cinema Camera, Cinema Camera EF and Production Camera 4K EF support the image stabilizer (IS) 
feature found in many active lenses. Simply set the Stabilizer switch to ON to use it with your camera. If your 
lens also features a Stabilizer Mode switch, set it to the appropriate mode for still shots or for movement.

When using battery power, the camera will only activate the image stabilizer while recording, as the lens 
draws additional power from the camera to operate the image stabilizer. When external power is connected 
to the camera, the image stabilizer will be active any time you set the lens stabilizer switch to ON.

Status Strip 
Your chosen settings are always displayed on a status strip, which runs the length of the LCD, showing 
a convenient summary of the camera's current settings.

Battery Life Indicator
When the remaining charge drops below 25% capacity, the status strip will show the battery status in 
red to warn you that battery life is running low.

SD/SSD Activity Icons
The status strip displays important information showing the state of the inserted media.

Moving Dots   When you see the moving dots, the camera is checking and preparing the 
media.

No Card/SSD  This means no media is detected or present in the camera.

Ready   Ready to Record.

Red Icon   Recording.

Flashing Red Icon Dropped Frames were detected.

Card/Disk Full  Appears when SD card or SSD is full.

Playback mode  Displays play, fast forward and reverse icons.

Timecode    Displays the duration of clips during recording and playback from your SD card  
or SSD.

1 2 3 4 65 8 97

1.  Media and Recording 
Status 

2. Timecode 
3. Recording Format  
4. Video Format/Frame Rate 

5. F-Stop
6. ISO Setting  
7. Shutter Angle 
8. White Balance
9. Battery Life Indicator
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What is the Slate?
The LCD on your Blackmagic camera has many purposes, one of which is to allow you to easily log 
metadata directly into the camera using the Slate feature. Metadata is stored in the recorded files and 
is easily accessed by editing software.

Pocket Cinema Camera
Step 1. Press OK once to make the slate appear, or press the Menu button to open the dashboard 

and select Metadata.

Step 2. Use the directional buttons to select the text you wish to change and press OK. An onscreen 
keyboard will appear. Use the directional buttons to select characters on the keyboard and 
press OK to confirm each character selection.

Step 3. Once you have typed in your information, select Save and press OK to return to the 
metadata screen.

Step 4. If you want the scene, shot or take number to auto-increment, select the corresponding 
auto-increment icon so it is illuminated and press OK.

Entering words into the Keywords field allows them to be used as search terms in your library database. 
This may be particularly useful for large projects with lots of material. The use of keywords narrows down 
the number of clips to search through, saving valuable time when you are editing.

All metadata is compatible with popular software such as Final Cut Pro X and DaVinci Resolve.

Cinema Camera and Production Camera 4K
Step 1. Tap the touchscreen once to make the slate appear. You can also access the Slate from the 

dashboard by pressing Menu, then selecting the Metadata icon.

Step 2. To enter or change details, tap the text you wish to change and an onscreen keyboard will 
appear. Type in the desired information and press the save button.

Step 3. If you want the scene, shot or take number to auto-increment, tap the corresponding auto-
increment icon so it is illuminated. Tap it again if you want to turn off the auto-increment feature.

Entering words into the Keywords field will allow you to use them as search terms in your library database. 
This may be particularly useful for large projects where you have lots of material. The use of keywords 
narrows down the number of clips to search through, saving valuable time when you are editing.

All metadata is compatible with popular software such as Final Cut Pro X and DaVinci Resolve.

The Slate feature lets you include metadata information in 
your clip files for post production.

On Cinema Camera and Production Camera 4K you can simply 
tap the display once with your finger and the slate will appear.

Select the auto-increment icon if you want the scene, shot  
or take number to auto-increment.

Entering Metadata
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Waveform Monitoring using Thunderbolt
When connected to a Mac OS X or Windows computer with Thunderbolt technology, your Cinema 
Camera or Production Camera 4K can be used as a powerful solution for waveform monitoring. Blackmagic 
Cinema Camera's Thunderbolt port always outputs uncompressed 10-bit 1080p HD video. Production 
Camera 4K matches the SDI output in either 10-bit 1080p HD or compressed Ultra HD 4K. For waveform 
monitoring using Production Camera 4K set the recording format to HD.

The Blackmagic Camera Utility installs Blackmagic UltraScope software for waveform monitoring of 
your camera during recording and playback. Blackmagic UltraScope allows you to monitor almost every 
aspect of the video you record with your Cinema Camera or Production Camera 4K.

Connect to your computer via the Thunderbolt port of your  
Cinema Camera or Production Camera 4K.

Blackmagic UltraScope software gives you accurate waveform monitoring via Thunderbolt.
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Using Blackmagic UltraScope
What is Blackmagic UltraScope?
Blackmagic UltraScope software provides waveform monitoring of the video output from your Cinema 
Camera or Production Camera 4K.

Previously, broadcast quality television and post production scopes were incredibly expensive and 
bulky solutions that only let you see one scope at a time on a tiny screen! Some scopes look ugly and 
unappealing to your client. With Blackmagic UltraScope, you get 6 wonderful scopes to monitor all 
aspects of your video signal, perfect for checking levels on your camera while shooting. Any camera 
adjustments are immediately seen using Blackmagic UltraScope!

Simply connect a Thunderbolt cable from your camera to the Thunderbolt port on your computer, turn 
on your camera and launch UltraScope!

Installation Requirements
The Blackmagic UltraScope software interface requires a computer display with a minimum resolution 
of 1280 x 800 pixels to view two scopes simultaneously. Blackmagic Design recommends viewing all 
6 scopes simultaneously by using a computer display resolution of 1920 x 1200 or 1920 x 1080 pixels.

Please see the support pages at www.blackmagicdesign.com/support for a comprehensive list of the 
latest minimum system requirements for Blackmagic UltraScope.

Understanding Blackmagic UltraScope Views
Blackmagic UltraScope has two different views available depending on your workflow needs and screen 
resolution. You have the choice of viewing six displays in “Full Screen” view, or for more compact viewing, 
choose any 2 displays in “2-up” view.

The display view can be selected from the View menu.

Choose Full Screen to enter Full Screen view. If this option is unchecked, 2-up view will be displayed. 
You can quickly switch between Full Screen view and 2-up view by using the hot key CMD-F on Mac OS 
X, or CTRL F on Windows.

In 2-up view, select the desired left and right scopes by opening the View menu or by right-clicking 
anywhere in the UltraScope window. Make your selections from the Left View and Right View menu options.

If you want the scopes to swap sides, select the left or right view and set it to be the same as the  
other view. The scopes will swap sides because the 2-up view never displays the same scope in both the 
left and right views.

Blackmagic UltraScope - Full Screen View. Blackmagic 
UltraScope lets you accurately monitor the video and  
audio levels from your Blackmagic Cinema Camera or 
Production Camera 4K.
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Screen Resolution Requirements for Display Views
 � Full Screen view: 1920 x 1200 pixels or 1920 x 1080 pixels. If your monitor doesn’t support 

these resolutions, then Full Screen view will not be available.
 � 2-up view: minimum resolution of 1280 x 800 pixels.

Blackmagic UltraScope Displays
Blackmagic UltraScope software is a great tool for maintaining accurate video and audio levels from 
your Blackmagic camera so you can make the most of your digital footage in post-production. Scopes 
used to monitor your levels include Vectorscope, RGB Parade, Histogram and Audio Metering Display.

RGB Parade Display
RGB parade displays the red, green and blue channels of your Blackmagic camera’s image. If one of the 
channels is elevated, it will indicate the presence of a color cast. For instance, any excessive elevation 
of a color channel will indicate that your white balance is incorrect.

You may want a certain color effect in your shot, for example when using a colored filter on your lens,  
like a warming filter. An elevated red channel will be normal, but you can also check the other color 
channels aren’t being overly crushed. The same applies if using intensely colored gels on your lights. 
Remember that any “look” you create in camera can be easily enhanced during post-production using 
a vectorscope and RGB parade in DaVinci Resolve.

The waveform of the RGB parade is great for checking if your Blackmagic camera’s image is clipped or 
crushed. Any clipping of highlights will be visible by a flat horizontal line at 100 IRE, or the upper level 
of your scope. Clipping results in a loss of image detail, so if there is image detail in your highlights that 
you want to preserve, adjust your lighting or exposure accordingly. Remember, it’s easy to clip out image 
information during color grading in DaVinci Resolve, but if detail is not present in the original exposure 
then it cannot be recovered in the grade.

RGB Parade Display

2-Up view
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Vectorscope Display
Vectorscope is useful for monitoring the color balance and saturation of your Blackmagic camera’s 
video signal. If your signal has a dominant green color cast then the majority of image information will 
be located towards the green area of the vectorscope. In comparison, an image with a neutral color 
balance will have information evenly distributed around the center.

The center of the vectorscope represents zero saturation. The further an object is from the center, the more 
saturated it appears. For example, if shooting green screen for compositing, you want the green screen to 
be as saturated as legally possible to achieve the best key or matte. Broadcast legal colors are maintained 
by ensuring the saturation levels don’t go beyond the graticule boxes on your vectorscope display.

The vectorscope can also be used to check your camera’s white balance on location. When zooming into 
a white object so it fills the camera’s frame, the vectorscope will show a cluster of information. Correct 
white balance will display information evenly clustered around the center. Adjust your camera’s white 
balance setting to see how it affects the display. 

Histogram Display
Using Histogram is another way to check for clipping, crushing and image contrast in your Blackmagic 
camera signal. The horizontal axis represents the luminance range with black on the left (0 in a 10 bit 
image) and white on the right (1023 in a 10 bit image). Clipping is displayed as image information clustered 
at the 1023 mark. Crushing is displayed as information clustered at the 0 mark. An image with good 
contrast will display information covering the entire horizontal axis, whereas a low contrast image will 
display information predominantly in the middle.

Audio Metering Display
Audio metering display shows you the audio levels embedded in your Blackmagic Camera's video signal. 
The 2 channels of embedded audio are displayed in either dBFS or VU format. dBFS is essentially a meter 
of the overall digital audio signal and is common on modern digital equipment. The VU meter shows 
average signal levels, is easy to use and very common on older equipment.

To monitor your audio levels, watch the VU meter and ensure the levels never peak above 0dB. Peaking 
above 0dB means your audio is clipping.

You can also monitor audio phase and balance using the audio metering display.

Vectorscope Display

Histogram Display

Audio Metering Display



Camera Video Output33

Monitoring using SDI
Blackmagic Cinema Camera supports 3G-SDI so it can be used to output uncompressed 10-bit 4:2:2 
video to routers, monitors, SDI capture devices, broadcast switchers and other SDI devices. 

Production Camera 4K supports 6G-SDI, so it can be used to connect to any SDI monitor as well as 4K 
switchers such as ATEM Production Studio 4K.

Connecting to Video Switchers
The SDI output allows you to use your camera as a television production camera. You can connect the SDI 
output directly to production switchers for studio work or to ATEM Camera Converters to convert your 
signal to optical so you can send it hundreds of meters to a broadcast truck for live production on location. 

If you have selected to record in 25 or 29.97 fps and set the SDI overlays to Off, the SDI output will be set 
to 1080i50 and 1080i59.94 respectively. This allows you to work with most switchers, which only support 
interlaced high definition formats.

Connecting to Monitors
SDI monitoring can be really handy when accessing the LCD is impractical, such as when secured high 
on a jib arm, on a crane, or mounted on a vehicle.

Monitoring information is displayed on your SDI output by adjusting the SDI Overlays options in the 
Display Settings menu. SDI Overlays provide frame guides and information such as recording details 
and camera settings. If you simply want to monitor your shots, you can always turn overlays off for a 
clean SDI output.

Connect the SDI output to SDI monitors for full 10-bit uncompressed monitoring or Blackmagic SmartScope 
Duo for live waveform monitoring. 

Connect a SDI cable from the BNC port of your Cinema 
Camera or Production Camera 4K to any SDI device.
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Working with Files from SSDs
To import your clips from a SSD:

Step 1. Remove the SSD from your Cinema Camera or Production Camera 4K.

Step 2. You can mount the SSD to your Mac OS X or Windows computer using either an eSATA or 
Thunderbolt dock. You can also use an eSATA to USB adapter cable to plug the SSD straight 
into a USB port on your computer. However, USB 2.0 is not fast enough to edit video in real 
time so this is not a recommended way to transfer files.

Step 3. Double click on the SSD to open it and you should see a list of QuickTime movie files or folders 
that contain your CinemaDNG RAW image files. Depending on the format you chose to record 
in, you might have a mixture of files, but they will all use the same naming convention.

Step 4. Now you can simply drag the files you want from the SSD onto your desktop or another hard 
drive, or you can access the files straight from the SSD using your NLE software. CinemaDNG 
RAW files are saved to the SSD as separate DNG images for each frame. This is an open format 
and you can use many software applications to view your RAW 2.5K images as a video sequence. 

Step 5. Before you unplug the SSD from your computer, it's always a good idea to eject the SSD 
safely using either Mac OS X or Windows first.

Working with Files from SD Cards
You can access your ProRes or CinemaDNG files straight from your SD card with any Mac OS X or Windows 
computer that features an SD card slot or by using an SD card reader. 

Step 1. Remove the SD card from your Pocket Cinema Camera and insert it into the SD card slot of  
your computer, or SD card reader. The SD card can be accessed the same way as you would an 
external hard drive, USB drive or any other media storage device attached to your computer.

Step 2. Double click on the SD card to open it and you should see a list of QuickTime movie files 
or folders which contain your CinemaDNG RAW image files. Depending on the format you 
chose to record in, you might have a mixture of files and folders, but they will all use the same  
naming convention.

Step 3. Now you can simply drag the files you want from the SD card onto your desktop or another 
hard drive, or you can access the files straight from the SD card using your NLE software.

Step 4. Before you physically remove the SD card from the SD card slot, it's always a good idea to 
eject the SD card safely using either Mac OS X or Windows first.

Edit directly from the SSD by removing it from your camera and 
mounting it on your computer using an eSATA Thunderbolt 
dock or USB 2.0 docking cable.

Post Production Workflow

HDMI

Insert your SD card into any computer with an SD card slot to 
access your clips immediately.
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Editing your Clips
To edit your clips using your favorite editing software, you can copy your clips to an internal/external 
drive or RAID and then import your clips into the software. Or import your clips directly from your SD 
card, or from your SSD using an external SATA adaptor, SSD Dock or docking cable.

Using RAW Files with DaVinci Resolve
CinemaDNG RAW clips may appear washed out or over exposed due to the high levels of information 
within them. To edit your RAW clips, they first need to be converted with a look that emulates standard 
video, or you can perform a proper grade and edit your graded clips. You can perform a basic 
conversion by importing your RAW clips into DaVinci Resolve and applying a look up table (LUT).  
The LUT will apply a basic color grade to emulate a standard video appearance. The graded clips are 
typically exported using ProRes settings and used as proxies until the final color grade, which will occur 
after the edit.

To convert your RAW clips using DaVinci Resolve:

Step 1.  Create a new project and set your video resolution and frame rate to match your RAW video 
clips. In this example we’ll use the 1080p format with a frame rate of 25.

Step 2.  Import your CinemaDNG RAW clips into the Media Pool.

Step 3.  Go to Project Settings and set your Input Settings to Scale Entire Image to Fit.

Step 4.  Go to Project Settings/Camera Raw and select CinemaDNG from the dropdown menu. Select 
Decode Using to Project.

Step 5.  Select the White Balance setting most suitable for your material.

Step 6.  Set Color Space to BMD Film and likewise set Gamma to BMD Film.

To apply the LUT, go to Project Settings/Look Up Tables, and set 3D Output Look Up Table to Blackmagic 
Cinema Camera Film to Rec709.

This will apply the LUT to every shot in the timeline. Click on the Color tab and check the results.  
The images should exhibit improved color and contrast.

RAW Wide Dynamic Range - With Blackmagic Cinema Camera, 
a wide dynamic range is captured with all details preserved

Final Color Graded Shot - The details are enhanced and the 
highlights are managed so your shots look cinematic!

RAW FILM DATA

VIDEO DATA
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At the very minimum do a quick check of the timeline for shots with excessive exposure or color issues. 
When you're satisfied with the appearance of the clips in the timeline, you’re ready to export your clips  
to ProRes.

To export your clips:

Step 1.  Click on the Deliver tab, go to the Easy Setup menu and select Export to Final Cut Pro.  
By default this preset will render Apple ProRes 422 (HQ).

Step 2.  Set Render Timeline As: to Individual Source Clips.

Step 3.  Ensure Render Each Clip With a Unique Filename is deselected.

Step 4.  Enable the Render Audio checkbox, select your audio channels and set to a bit depth of 24. 

Step 5.  Under Render Job To: click Browse. Choose a new folder for your converted clips.

Step 6.  Click Add Job.

Step 7.  Click Start Render.

Upon completion of the render you will have a folder that contains each individual clip from the Resolve 
timeline. The converted clips can now be imported into your editing software. You can always make 
adjustments to your grade by exporting an XML from your editing software.

Using Final Cut Pro X
To edit Apple ProRes 422 (HQ) clips using Final Cut Pro X, you need to create a new project matching  
your clips’ video format and frame rate. For this example, clips are set using ProRes 422 (HQ) 1080p25 
camera settings.

Step 1.  Launch Final Cut Pro X, go to the Menu bar and select File/New Project. A window will open 
containing project settings.

Step 2.  Name your project and select the Custom checkbox.

Step 3.  Set the Video Properties settings to 1080p HD, 1920x1080 and 25p.

Step 4.  Set your Audio and Render Properties settings to Stereo, 48kHz, and Apple ProRes 422 (HQ)

Step 5.  Click OK.

To import your clips into your project, go to the Menu bar and select File/Import/Media. Choose your 
clips from your SSD or SD Card.

You can now drag your clips onto the timeline for editing.

DaVinci Resolve project settings.

Final Cut Pro X project settings.
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Using Avid Media Composer
To edit your DNxHD clips using Avid Media Composer 7, create a new project matching the clip’s video 
format and frame rate. For this example, clips are set using DNxHD 1080i59.94 camera settings.

Step 1.  Launch Media Composer and the Select Project window will appear. Click the New Project 
button.

Step 2.  In the New Project window name your project.

Step 3.  Go to the Format dropdown menu and select 1080i/59.94.

Step 4.  Go to the Color Space dropdown menu and select YCbCr 709.

Step 5.  Go to the Raster Dimension dropdown menu and select 1920x1080. Click OK.

Step 6.  Select Tools>Background Services and click the "Start" button if background services are 
not already running and then click "OK." 

Step 7.  Select the media bin where you wish to import your files.

Step 8.  Select File>AMA Link... and select the files that you wish to import and then click "OK."

When the clips appear within the media bin you can drag your clips onto the timeline and begin editing.

Using Adobe Premiere Pro CC
To edit your Apple ProRes 422 (HQ) or DNxHD clips using Adobe Premiere Pro CC, you need to create 
a new project matching your clips’ video format and frame rate. For this example, clips are set using 
ProRes 422 (HQ) 1080p25 camera settings.

Step 1.  Launch Adobe Premiere Pro CC. In the Welcome window select Create New/New Project.  
A window will open containing project settings.

Step 2.  Name your project. Choose the location for your project by clicking Browse and selecting your 
desired folder. Once you’ve selected your location folder click OK in the Welcome window.

Step 3.  Go to the Adobe Premiere Pro CC Menu bar, select File/Import and choose the clips you 
want to edit. Your clips will appear in the Project window.

Step 4.  Drag the first clip you wish to edit onto the New Item icon at the bottom right of the Project 
Window. A new sequence will be created matching your clip settings.

You can now drag your clips onto the sequence timeline for editing.

Setting the project name and project options in Avid Media 
Composer 7.

Setting the project name and project options in Adobe 
Premiere Pro CC.
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Using Autodesk Smoke 2013
To edit your clips using Autodesk Smoke 2013, create a new project matching the clips’ video format,  
bit depth, frame type and frame rate. For this example, clips were shot using ProRes 422 (HQ) 1080p25 
camera settings.

Step 1. Launch Smoke and the Project and User Settings window will appear. Click on the New button 
under the project heading.

Step 2. The Create New Project window will open. Name your project.

Step 3. From the resolution dropdown menu, select 1920x1080 HD 1080. 

Step 4. Make sure bit depth is set to 10-bit and frame type is Progressive.

Step 5. From the Config Template dropdown menu select 1920x1080@25000p.cfg.

Step 6.  Leave the Preferred Format set to ProRes 422 (HQ) and click Create.

Step 7. Click on the New button under the User heading.

Step 8. When the Create New User Profile window opens, type your user name and click Create.

Step 9. When the Project and User Settings window reopens, click the Start button.

Step 10. From the menu bar, select File>Import>File and select your clips to import.

Step 11. Once the clips appear in the media library you can drag your clips onto the timeline and  
begin editing.

Setting the project name and project options in Autodesk 
Smoke 2013.
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How to Update Your Camera Software on Mac OS X
After downloading the Blackmagic Camera Utility software and unzipping the downloaded file, open 
the resulting disk image to reveal its contents.

Before launching the installer, we recommend first clicking the Uninstall Blackmagic Camera Utility 
icon to remove any previously installed camera software from your computer. If you have no previously 
installed camera software on your computer, launch the Blackmagic Camera Installer and follow the 
onscreen instructions.

How to Update Your Camera Software on Windows
After downloading the Blackmagic Camera Utility software and unzipping the downloaded file,  
you should see a Blackmagic Camera Utility folder containing this PDF manual and the Blackmagic 
Camera Utility installer.

Double-click the installer and follow the onscreen prompts to complete the installation.

How to Update the Camera Software
After installing the latest Blackmagic Camera Utility on your computer, connect a USB cable between  
the computer and the camera. On Pocket Cinema Camera, the Mini USB 2.0 port is located inside the 
battery terminal. On Cinema Camera and Production Camera 4K, the Mini USB 2.0 port is located 
behind the SSD door.

Launch the Blackmagic Camera Utility and follow any onscreen prompt to update the camera software.

The Mini-USB 2.0 port can be found behind the SSD door on 
Cinema Camera and Production Camera 4K.

The Mini-USB 2.0 port can be found behind the battery 
terminal door on Pocket Cinema Camera.
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Wrist Strap
Pocket Cinema Camera comes with a wrist strap for convenient carrying of the camera when on the 
move from location to location.

To fasten, loop the string on the end of the strap through the ring on the camera, located to the bottom 
right of the LCD. Loop the rope end of the wrist strap back through the string, making a secure knot.

Sun Shield
Cinema Camera and Production Camera 4K include a detachable sun shield to shade the touchscreen 
in bright conditions and ensure optimum viewing is possible at all times.

Line up the sun shield's locking tabs and gently push into the camera.

To remove the sun shield either:

Option 1. Hold the top of the shield in the middle and gently pull out, making sure it releases evenly 
on both sides.

Option 2. Using your thumbs, gently press the side locking tabs outwards using equal pressure and 
pull out the shield. Do not pull the sun shield out one side at a time, as you may damage the 
locking tabs.

Carry Strap
Cinema Camera and Production Camera 4K come with a carry strap for convenient carrying of the camera 
when on the move from location to location.

To fasten, loop the end of the strap through the metal hook on the top of the camera, and secure through 
the plastic clasp to the desired length.

Option 1.

Option 2.

Cinema Camera and Production Camera 4K carry strap.

Pocket Cinema Camera wrist strap.
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Camera Handles
Optional handles for Cinema Camera and Production Camera 4K allow shooting in locations where  
you need to move around quickly with your camera. The handles let you steady your shot and keep up 
with the action!

On the underside of the camera, locate the ¼” screw thread and insert the guide pin, locking the handles 
to the camera.
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Getting Help
The fastest way to obtain help is to go to the Blackmagic Design support pages and check the latest 
support material available for your camera.

Blackmagic Design Online Support Pages
The latest manual, software and support notes can be found at the Blackmagic Design support center at  
www.blackmagicdesign.com/support.

Contacting Blackmagic Design Support
If you can't find the help you need in our support material, please use the "Send us an email" button on 
the support page to email a support request. Alternatively, click on the "Find your local support team" 
button on the support page and call your nearest Blackmagic Design support office.

Checking the Software Version Currently Installed
To check which version of Blackmagic Camera Utility software is installed on your computer, open the 
About Blackmagic Camera Utility window.

 � On Mac OS X, open Blackmagic Camera Utility from the Applications folder. Select About 
Blackmagic Camera Utility from the application menu to reveal the version number.

 � On Windows, open Blackmagic Camera Utility from your Start menu or Start Screen. Click on 
the Help menu and select About Blackmagic Camera Utility to reveal the version number.

How to Get the Latest Software Updates
After checking the version of Blackmagic Camera Utility software installed on your computer, please visit  
the Blackmagic Design support center at www.blackmagicdesign.com/support to check for the latest 
updates. While it is usually a good idea to run the latest updates, it is wise to avoid updating any software 
if you are in the middle of an important project.

Battery Replacement
Cinema Camera and Production Camera 4K's built in battery is not user-servicable. Should the battery 
require replacement, you will need to send it to your nearest Blackmagic Design service center for 
replacement. If the camera is outside of its warranty period, the battery replacement will incur a small 
service fee for the cost of the battery, labor and return of the camera to you. Please contact Blackmagic 
Design Support to find out details of where to send your camera, how to package it safely and how much 
the replacement will cost in your country.

Help



Help43

Replacing the Fan
Cinema Camera and Production Camera 4K each contain a fan, which is necessary for cooling. If you 
detect the fan is not working, or is making a strange noise, switch off the camera and order a replacement 
fan by contacting Blackmagic Design Support. You should use an anti-static strap to avoid damaging 
the camera while opened.

To replace the fan:

Step 1. Switch off the camera and remove any external cables.

Step 2. Place the camera upside down on a bench, with the tripod hole facing up, and the touchsceen 
facing towards you. You will see a metal panel labelled "Fan". This panel is attached to a fan 
module inside the camera. Remove the four screws from this panel using a number 01 size 
Phillips head screwdriver. Thread-locking fluid has been applied to the screws which will 
require additional force to unscrew them. Keep the screws as you will need them again.

Step 3. Gently lift the fan module up and out of the camera, taking care NOT to pull the wires that 
connect to the inside of the camera. Accidentally pulling on these wires could cause them 
to become unplugged from an inaccessible location inside the camera, which would need 
to be fixed by a Blackmagic Design service center.

Step 4. Locate the white plastic plug a short distance along the wires from the fan. Pull the plug apart 
using both hands so that no stress is placed on the wires that continue inside the camera. 
You can now discard the old fan module.

Step 5. Connect the white plastic plug to the wires of the replacement fan module. Reinstate the fan 
module in its hole with the "Fan" label the right way up. The fan module can only be installed 
in one orientation. Reinstate the four screws into the fan plate to finish replacing the fan. 

Step 6. Switch on the camera and you should feel a gentle flow of air coming from the vent holes in 
the fan module.

FAN
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12 Month Limited Warranty
Blackmagic Design warrants that this product will be free from defects in materials and workmanship for 
a period of 12 months from the date of purchase. If a product proves to be defective during this warranty 
period, Blackmagic Design, at its option, either will repair the defective product without charge for parts  
and labor, or will provide a replacement in exchange for the defective product. 

In order to obtain service under this warranty, you the Customer, must notify Blackmagic Design of the 
defect before the expiration of the warranty period and make suitable arrangements for the performance 
of service. The Customer shall be responsible for packaging and shipping the defective product to a 
designated service center nominated by Blackmagic Design, with shipping charges pre paid. Customer 
shall be responsible for paying all shipping charges, insurance, duties, taxes, and any other charges for 
products returned to us for any reason. 

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or 
inadequate maintenance and care. Blackmagic Design shall not be obligated to furnish service under 
this warranty: a) to repair damage resulting from attempts by personnel other than Blackmagic Design 
representatives to install, repair or service the product, b) to repair damage resulting from improper 
use or connection to incompatible equipment, c) to repair any damage or malfunction caused by the 
use of non Blackmagic Design parts or supplies, or d) to service a product that has been modified or 
integrated with other products when the effect of such a modification or integration increases the time 
or difficulty of servicing the product. THIS WARRANTY IS GIVEN BY BLACKMAGIC DESIGN IN LIEU OF 
ANY OTHER WARRANTIES, EXPRESS OR IMPLIED. BLACKMAGIC DESIGN AND ITS VENDORS DISCLAIM 
ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
BLACKMAGIC DESIGN’S RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE 
WHOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR ANY INDIRECT, SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER BLACKMAGIC DESIGN 
OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES. BLACKMAGIC 
DESIGN IS NOT LIABLE FOR ANY ILLEGAL USE OF EQUIPMENT BY CUSTOMER. BLACKMAGIC IS 
NOT LIABLE FOR ANY DAMAGES RESULTING FROM USE OF THIS PRODUCT. USER OPERATES THIS 
PRODUCT AT OWN RISK. 

© Copyright 2014 Blackmagic Design. All rights reserved. ‘Blackmagic Design’, ‘DeckLink’, ‘HDLink’, ‘Workgroup Videohub’, ‘Multibridge 
Pro’, ‘Multibridge Extreme’, ‘Intensity’ and ‘Leading the creative video revolution’ are registered trademarks in the US and other countries. 
All other company and product names may be trade marks of their respective companies with which they are associated.
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